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How to Use This Manual

Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.

n Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

Related Information

= Links to related sections.

Trademarks

(4 EPSON and EXCEED YOUR VISION are registered trademarks of the Seiko Epson Corporation.
(d Microsoft and Windows are registered trademarks of the Microsoft Corporation in the US and other countries.

(d Other product names may be trademarks or registered trademarks of their respective owners.

© Seiko Epson Corporation 2021. All rights reserved.



Contents

How to Use This Manual
Marks and Symbols. . . ...... .. .. oL

Trademarks. . .......... ... ... .
Collecting device information

System Requirements
SupportedOS. . ... .. ...

Essential Software. . . ............ ... .. ....

Supported Drivers. .. . ...... .. i

Allowing protocols

Opening the protocol you want to use
(registering a firewall exception). . . .. ...........

Precautions

Installing the ED USB Agent




Collecting device information

Collecting device information

Epson Device Admin communicates with ED USB Agent over the intranet.

ED USB Agent communicates with a USB-connected device using its driver.

Administrator Operator Device
‘duld.u_,; _aad
[
Epson Device HTTPS ED USB Printer Driver UsB S

Admin Agent Scanner Driver -
— .

To allow Epson Device Admin to discover and manage devices connected to computers on the network by USB
cables, you need to install the ED USB Agent on all computers on the network to which the devices you want to
manage are connected.

Next, specify the IP addresses or IP address ranges of the computers under Discovery Parameters from Options in
Epson Device Admin.

You can automatically assign devices discovered through Epson Device Admin's discovery function to a group. You
can select Network or USB as the automatic assignment condition when Connection is selected for Device
Information. For more information, see the “Create and edit user-defined groups” chapter in the Epson Device
Admin User's Guide.

Epson large format printers and color label printers (ColorWorks series) do not support ED USB Agent. They can
be discovered and monitored by Epson Device Admin only through network connections.
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System Requirements

Supported OS

Microsoft Windows 7 (SP1) / 7 x64 Edition (SP1)
Microsoft Windows 8 / 8 x64 Edition

Microsoft Windows 8.1 / 8.1 x64 Edition
Microsoft Windows 10 / 10 x64 Edition
Microsoft Windows 11 x64 Edition

Microsoft Windows Server 2008 (SP2) / x64 Edition (SP2)
Microsoft Windows Server 2008 R2 x64 Edition
Microsoft Windows Server 2012 x64 Edition
Microsoft Windows Server 2012 R2 x64 Edition
Microsoft Windows Server 2016 x64 Edition
Microsoft Windows Server 2019 x64 Edition
Microsoft Windows Server 2022 x64 Edition

Essential Software

(d Runtime library: .NET Framework 4.0 or later

(d Enable "Desktop Experience", if you want to collect scanner information by using the computer that is running
on Windows Server.

Supported Drivers

[ Printer: Printer Driver, EPSON Universal Print Driver version 2.67 or later
(4 Scanner: EPSON Scan (Scanner Driver), Epson Scan 2 (Scanner Driver)

[ Check Scanner: USB Driver version 3.00 or later*

* TMUSB Device Driver is not supported.
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Allowing protocols

You need to allow the following protocols on Operator PC to establish communication between Epson Device
Admin” and ED USB Agent.

Computer on Which to Open a Port Protocol Port Number
Operator's computer with ED USB Agent TCP/UDP 64122 (default)
installed

You can allow communication through the
firewall during ED USB Agent installation. In
this case, you do not need to open a port.

ICMP (Ping) -

*: Epson Device Admin v3.0 or later is supported.

Opening the protocol you want to use (registering a
firewall exception)

L. Click Network & Internet in the Windows Settings menu.

Settings - o X

Windows Settings

g System

power

5

Devices

D Phone @ Network & Internet

@ Personalization E; Apps
Background, lock screen, colors 8= Uninstall, defaults, optio
Accounts ™ Time & Language
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2. Click Windows firewall in the Change your network settings.

<« Settings - m] x
G Home Status
| ' 3 settir | Change connection properties
Network & Internet Show available networks
| & sous Change your network settings
Ethernet .
@ Change adapter options
View network adapters and change connection settings.
% Dial-up
% Sharing options
°P VPN For the networks you connect to, decide what you want to share.
View your network properties
4)= Airplane mode
(& Data usage
MNetwork and Sharing Center
kg Proxy Netwark reset

Have a question?

Got haln

3. Click Advanced settings.

Windows Security - O X

« Firewall & network protection

Who and what can access your networks.

@
V) B Domain network
Q Firewall is on.
X
= @ Private network
Firewall is on,
a2
@ 3 Public network (active)
& Firewall is on.

Allow an app through firewall
MNetwork and Internet troubleshooter
Firewall notification settings

Advanced settings
@

Restore firewalls to default
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4. Click Inbound Rules.

5.

Eile Action View Help
L Ao o
e

‘ Windows Defender Firewall with Advanced Security

Windows Def irewall with Advanced Security on Local Computer

Actions

# | Windows Defender Firewall... «
‘ Windows Defender Firewall with Advanced Security provides network security for Windows computers. N
*i Connection Security Rules ]| Import Policy...
> & Monitoring 4a| Export Policy...
Oixaviey - Restore Default Policy
I:_)nmaln Profile Diagnose / Repair
@ Windows Defender Firewall is on.
- View 4
Q Inbound connections that do not match a rule are blocked.
@ Outbound connections that do not match a rule are allowed. |G Refresh
Private Profile [ Properies
& Windows Defender Firewall is on. Help
() Inbound connections that do not match 2 rule are blocked
@ Outbound connections that do not match a rule are allowed.
Public Profile is Active
@ Windows Defender Firewall is on.
© Inbound connections that do not match a rule are blocked.
@ Outbound cornections that do not mateh a rule are allowed.
g Windows Defender Firewall Properties
Getting Started -
Authenti icati b p s
Greate connection security rules to specify how and when connections between computers are authenticated
and protected by using Internet Protocol security (IPsec)
B3 Connection Security Rules
View and create firewall rules
Greate firewall rules to allow or block connections to specified programs or ports. You can also allow a
connection only if it is suthenticated, or if it comes from an suthorized user, group, or computer. By default, v
Click New Rule.
ﬂ Windows Defender Firewall with Advanced Security — [m] x
File Action View Help
ol ARl cai ERN 7]
Inbound Rules [heme  laowp  |piofie |Enobled | Action ) NS "
Outbound Rules o
Connection Security Rules || & @FirewallAPLdIl-80201 @FirewallAP1.dll,-20200 Al Ves Allow
» %, Monitoring 9 @FirewallAPL.dIl-80206 @FirewallAP1.dl,-80200 Al Yes Allow —_— ,
Allloyn Router (TCP-In) Allloyn Router Domai... Yes Allow
Allloyn Router (UDP-Ir) Alllayn Router Domai.. Ves Allow W Filter by State 4
@ App Installer App Installer Domai.. Yes Allow 7 Filter by Group r
BranchCache Content Retrieval (HTTP-In)  BranchCache - Content Retr...  All No Allow View »
BranchCache Hosted Cache Server (HTTP... BranchCache - Hosted Cach... All No Allow
BranchCache Peer Discovery (WSD-In) BranchCache - Peer Discove... All No Allow G Refresh
Cast to Device functionality (qWave-TCP... Cast to Device functionality ~ Private.. Ves Allow | ExportList..
1 Cast to Device functionality (qWave-UDP... Cast to Devicefunctionality ~ Private.. Yes Allow H Help
Cast to Device 55DP Discovery (UDP-In) Cast to Device functionality Public Yes Allow
{0 Cast to Device streaming server (HTTP-5t...  Cast to Device functionality Public Yes Allow
Cast to Device streaming server (HTTP-St... Cast to Device functionality ~ Private  Ves Allow
¥ Cast to Device streaming server (HTTP-St... Cast to Device functionality Demain  Yes Allow
Cast to Device streaming server (RTCP-5tr... Cast to Device functionality Private  Yes Allow
{0 Cast to Device streaming server (RTCP-Str... Cast to Device functionality Public Yes Allow
1 Cast to Device streaming server (RTCP-Str... Cast to Devicefunctionality ~ Domain  Yes Allow
Cast to Device streaming server (RTSP-5tr...  Cast to Device functionality Domain  Yes Allow
{0 Cast to Device streaming server (RTSP-Str... Cast to Device functionality Public Ves Allow
Cast to Device streaming server (RTSP-Str... Cast to Device functionality ~ Private  Ves Allow
& Castto Device UPnP Events (TCP-In) Cast to Device functionality Public Yes Allow
Connect Connect All Ves Allow
Connected Devices Platform - Wi-Fi Dire... Connected Devices Platform  Public Yes Allow
Connected Devices Platform (TCP-In) Connected Devices Platferm Domai... Yes Allow
Connected Devices Platform (UDP-In) Connected Devices Platform  Domai.. Yes Allow
Core Networking - Destination Unreacha... Core Metworking All Yes Allow
Core Networking - Destination Unreacha... Core Metworking All Yes Allow
Core Networking - Dynamic Host Config... Core Metworking All Yes Allow
#h Cre Netwnrkinn - Mhinamic Hoct Canfin - Core Mehwnrkinn all Ve Al Y
< 3|« >
Mew Rule...
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6. Select Port, and then click Next.

WP New Inbound Rule Wizard x
Rula Type
Select the type of frewall rule 1o creste.
B
& Fuls Tpa What type of nule would you like fo creste”
@ Frotocs] and Ports
& Actan ) Prosaram
Flle that controls connections for a proerss

& Profile
» Hare ) Port

) Rulbe that confrole cornmctons for 8 TCP or UDP port.

BF rewaBAFLAIL- 30200
Pule that controls connections for 3 Windows experience,

) Cumlomm
Custom rule.

7. Select TCP, enter “64122” in Specific local ports, and then click Next.

WP New Inbound Rule Wizard

Protocol and Ports
Specity the pretocols and ports 1o which %his rule soeles.
B

* Pule Troe

Fines this nae sy 1o TGP or LDF?
@ Protocel and Porty.
& Actum

TP
UoF
& Profile

@ Hame Do this: nue sy o 81 local nts o spmcil:

) Al bocal ports
W) Seweific: bocal perts [’m ] ]

Example: B3, 441, B0M-E010

8. Select Allow the connection, and then click Next.

WP New Inbound Rule Wizard

Actlon
Spacity the action % be taken when & cornection matchas the corditions specifisd in the nals

What action should be taken when a cornection maiches the specified conditions™

1 Mlow the connection
This inchades cannections that are prosected with IPsec a5 well a3 those are nat

1) Al e corwmcdion # i i securs

This inchades only connections that have been suthenticated by using IPsec
and s e

the sntlegs r

be
Cornaction Security Fule node.

() Bock the conmection




Allowing protocols > Opening the protocol you want to use (registering a firewall exception)

9. Select appropriate option(s) according to your environment, and then click Next.
[ @ New Inbound Rule weard x
| Profike

| Seacity the protiles for which this ns spaliss

When does this rule 300k

[ Diomain
Ppplies when & comguter it connected b it corporste domain.

(] Private
Ppplies when & comguter it connected 1o & privats natwork location. tuch a2 &
Fime dr werk. place

] Puslie:
Applms: rhens & comgriter i cormmciad bo & puble: retwork location

cm —

10. Enter the name for the new rule, and then click Finish.

[ @ New Inbound Rule weard x
| Hame

| Seecity the name and dsscriotion of this rule

M=l
The TCP protocol for port 64122 has been opened.

Next, open the UDP protocol for port 64122.

11. Repeat steps 4 to 10. However, select UDP in step 7 and continue.

[ @ New Inbound Rule weard x

| Protocoland Ports.
| Soecity the pretocols and ports to which this rule aceles

i'th

@ Puls Type [iews this nale anply to TGP o LOFY
@ Protoce] and Ports O Tee

& Acton ) UDP

& Profile

a Mame

Dloect this: nabe apby bl kcal forts or spmeile: kel ports?
©) M ol ports

W St bocal ports [una7 ]
Example: B3, 441, B0M-E010

cm —

The UDP protocol for port 64122 has been opened.
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Next, allow the computer to receive an echo request (Ping).

12. Select File and Printer Sharing (Echo Request - ICMPv4-In) on the Windows Defender Firewall with
Advanced Security screen, and then click Enable Rule.

@ Windows Defender Firewall with Advanced Security - [m] X
File Action View Help
L I llEY
Inbound Rules Name Group Profile  Enabled || Inbound Rules -
Outbound Rules
B4 Connection Security Rules || Distibuted Transaction Coordinator (RPC-EPMAP)  Distributed Transaction Coo... Private... No i@ NewRule..
%, Monitoring Distributed Transaction Coordinator (RPC-EPMAP)  Distributed Transaction Coo... Demain  No T Filter by Profile ,
Distributed Transaction Coordinator (TCP-In) Distributed Transaction Coo... Domain  No
Distributed Transaction Coordinator (TCP-In) Distributed Transaction Coo.. Private.. Mo T Filter by State 4
- 7 Filter by Group 3
Domain View »
Private...
|G Refresh
File and Printer Sharing (Echo Request - ICMPvE-In)  File and Printer Sharing Domain  No |5 Export List...
File and Printer Sharing (LLMMR-UDP-In) File and Printer Sharing All Na Help
File and Printer Sharing (MB-Datagram-In} File and Printer Sharing Domain  No
File and Printer Sharing (MB-Datagram-In) File and Printer Sharing Private.. No e *
File and Printer Sharing (MB-Mame-In} File and Printer Sharing Domain  No ' i EnableRule
File and Printer Sharing (MB-Mame-In) File and Printer Sharing Private.. No ey
File and Printer Sharing (MB-Session-In) File and Printer Sharing Private.. Ne .
File and Printer Sharing (MB-Session-In) File and Printer Sharing Domain Mo G Copy
File and Printer Sharing (SMB-In) File and Printer Sharing Private... Mo K Delete
File and Printer Sharing (SMB-In) File and Printer Sharing Demain - Ne Help
File and Printer Sharing (Spooler Service - RPC) File and Printer Sharing Private.. No
File and Printer Sharing (Spooler Service - RPC) File and Printer Sharing Domain  No
File and Printer Sharing (Spoceler Service - RPC-EPM...  File and Printer Sharing Private.. Ne
File and Printer Sharing (Spooler Service - RPC-EPM...  File and Printer Sharing Domain  No
File and Printer Sharing over SMBDirect (WARP-In) File and Printer Sharing over...  All Na
& Game bar Game bar Al Ves
@ Groove Music Groowve Music Domai... Yes
HomeGroup In HomeGroup Private Mo
HomeGroup In (PNRP) HomeGroup Private No
iSCSI Service (TCP-In) iSCSI Service Domain  Ne
PGSl Cariics (TCD-In) iGrSl Sarics Drivate N e
< >« >
Enable Rule

The protocol required for communication has been released. Close the windows.
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Precautions

Precautions

The agent cannot collect device information just after installing the printer or scanner driver. In this situation, you
need to reboot your computer.

In the following situations, the agent cannot collect device information. Instead, the agent returns the device
information collected the last time.

[ When printing from a computer to a USB connected printer

[ When the computer and scanner are connected by USB and EPSON Scan or Epson Scan 2 is running

Epson Device Admin v3.1 or later supports firmware updating for USB connected devices.

When a computer on which ED USB Agent is installed enters sleep mode, Epson Device Admin cannot
communicate with ED USB Agent and the status of the USB connected device changes to “Not Ready”.

After the computer wakes from sleep mode, it takes about 10 minutes for ED USB Agent v4.1.0 or earlier to
reestablish communication with the USB connected device. If necessary, disconnect and reconnect the USB cable
to quickly reestablish communication.

12



Installing the ED USB Agent

Installing the ED USB Agent

1. Run the following files according to your environment.
32 bit OS: EDUSBAgentSetup86.msi
64 bit OS: EDUSBAgentSetup64.msi

A Caution:

Do not run EDUSBAgentConfiguration.exe in the installation folder.

2. (Click Next.

15 Epson Device USB Agent Setup - x

Welcome to the Epson Device USB Agent Setup Wizard

The Setup Wizard will install Epson Device USE Agent on your computer, Click Next to
continue or Cancel to exit the Setup Wizard.

Cancel

3. Read the licensing agreement, select I accept the terms in the License Agreement, and then click Next.

1% Epson Device USB Agent Setup — <

End-User License Agreement

Please read the following license agreement carefully

SEIKO EPSON CORPORATION -
SOFTWARE LICENSE AGREEMENT

MPORTANT! READ THIZ SOFTWARE LICEMSE AGREEMENT CAREFULLY.
The cormputer software product, fontwars, tupsfaces sndfor dsta,
including any accompanying explanatory written materials (the
“Software”) should only be installed or used by the Licenses (“you”) on
the condition you agree with SEKO EPSON CORPORATION ("EPSON")
to the terms and conditions set forth in this Azreement. By installing or
Using the Software, you are representing to agree all the terms and

[ 11 accent the terms in the License Agreement! ]

Back Cancel

13



Installing the ED USB Agent

4. Select the folder in which to install the software and the port number, and then click Next.

1% Epson Device USB Agent Setup
Destination Folder

Click Next to install to the default folder or dick Change to choose another.

Install Epson Device USB Agent to:

(C:¥Program Files¥EPSON¥Epson Device USE Agent

Change...

Port Number

Iﬁqlll

runcunes w 8ccess Epson Device USB Agent. Enter a port number that is not
used by other software or services.

Back [

Cancel

Note:

You need to select the same port number as the Port number in Options > System Administration > USB Agent
Settings in Epson Device Admin.

Ipssn Drvice Ademin

_ =]

[ —

USE Agest Settings
Part sumber s4127

ey Serves Semegs

4 o Defauit Greusps i

0 Devices ()

i Pew Deviess 1)

i Combgured Devices 10
i Ungrouped Devices [0

£ Warrinng Devices D)

ti proy
¥ Uie syftern prowy settings
i Ermee Devices )
i Unressasve Devtet
B Ut Defrues Gronsp

Manual peosy confiquraion

Restare Dedst Settings
T Devices

R e
B repors

H contguation

et e

5. Click Install.

13 Epson Device USB Agent Setup

Ready to install Epson Device USB Agent

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Cancel

14



Installing the ED USB Agent

6. Click Finish when the installation complete window is displayed.

1% Epson Device USB Agent Setup — <

Completed the Epson Device USB Agent Setup Wizard

Click the Finish button to exit the Setup Wizard.

Cancel

The setup is complete.
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